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GIfMI Mock MRI Manual 
GIfMI Mock Scanner 

1 Introduction 
This document describes the use of the MRI Simulator installed at GIfMI. 

For more information, go to the GIfMI web site (http://gifmi.ugent.be) or contact Rik.Achten@UGent.be   (GIfMI Director) 

or Pieter.Vandemaele@UGent.be (GIfMI Site Manager). 

2 Motivation 
In April 2010, GIfMI purchased a MRI Simulator from Psychology Software Tools, Inc. (http://www.pstnet.com). A MRI 

Simulator is a device to simulate the MR environment and experience of being scanned in a controlled, safe and cost-

effective way. 

MR studies often require long scan periods with compliant participants. A MR study may be a traumatizing experience 

causing excessive movement resulting in data loss and lost funds. Especially in special populations like children, elderly 

and psychiatric or anxious participants this may result in a higher rate of premature termination of the study. 

Also researchers may benefit from the use of the MRI Simulator. They can get acquainted to the whole process of 

instructing and positioning subjects without occupying the real scanners. They can also train participants in a realistic 

environment to get acquainted with the paradigms. 

All this results in more effective use of scanner time, reducing the costs, optimize participant cooperation and higher data 

quality. 

More information on the benefits (including literature) can be found on the website of the manufacturer, see 

https://pstnet.com/product_category/mri-simulationtraining/. 

3 Equipment 
The MRI Simulator consists of several components which are all described below: 

3.1 MRI Simulator 

More information: https://pstnet.com/products/mri-simulator/ 

This is the main and largest component of the setup. The basic features are: 

• Standard 60 cm circular bore with tapered entry and front façade panel 

• Realistic scanner body with sturdy steel frame construction 

• Cooling fans and diffused lighting for participant safety and comfort 

• Amplified speakers with subwoofer for realistic scanner noise production and vibration 

• Quiet, motorized participant table with drag sensing safety stop and dynamic speed control 

(table speed ramps up or down for smooth starts and stops during participant insertion and extraction) 

• Integrated control panel for participant table operation, fans, and lights 

• Siemens mock birdcage head coil 

 

http://gifmi.ugent.be/
mailto:Rik.Achten@UGent.be
mailto:Pieter.Vandemaele@UGent.be
http://www.pstnet.com/
https://pstnet.com/product_category/mri-simulationtraining/
https://pstnet.com/products/mri-simulator/
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3.2  

 

 

MRI Simulator Siemens mock birdcage head coil 
 

3.3 SimFX 

 

https://pstnet.com/products/simfx/ 

3.4 SimFx software simulates the ambient scanner sound and the active scanning noise. Four sound files 

can be played simultaneously. SimFx also has the capability to accept input from an experimental 

paradigm which can be used to simulate how the scanner synchronization pulse triggers an experiment. 
 

3.5 MoTrack 

 

https://pstnet.com/products/motrak/ 

MoTrak is a system to track head motion in real time. The sensor attached to the subject’s head determines the position 

of the head in space relative to the transmitter. The sensor records angular rotations as well as positional displacements 

from an initially calibrated position. This information is displayed and logged by the program in real-time, allowing 

observation of head motion in A MRI simulator.  

3.6 Monitor 

A standard monitor with VGA connection is located at the end of the bore. Keep in mind that due to the mirror, the image 

is mirrored left-to-right. 

3.7 Laptop 

A laptop is available to run the SimFX software. A researcher who wants to train subjects with a paradigm must bring a 

laptop. 

 

 

  

https://pstnet.com/products/simfx/
https://pstnet.com/products/motrak/
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4 Location 
The MRI Simulator can be reached in the following ways: 

From outside: Entrance 71 – route 737 – room DWL.0.021 

From the MR Building: Hall DWL.0.060 – Hall DWL.0.005G – Hall DWL.0.007G – room DWL.0.021  
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5 Access 
Access to the MRI Simulator room is only possible with a key. For sporadic access, please contact the GIfMI Site Manager 

to get the key. If you will be using the MRI Simulator frequently, please apply for a key using the GIfMI Key Application 

Form. 

6 Booking the MRI Simulator 
The MRI Simulator can only be booked using the GIfMI Resource Booking System. Therefor you need a user account on 

the GIfMI website. See the GIfMI User Account document for more information. For more information on how to make a 

booking, see the GIfMI Booking Manual. 

The GIfMI Site Manager must always be contacted prior to the start of a study using the MRI Simulator for up to date 

information and login credentials to the laptop. 

7 Usage 
Manuals for the software and hardware are available as PDF file. Check the website to download the manuals or send a 

request to the GIfMI Site Manager. 

Available manuals are: 

• MRI_Simulator_Manual.pdf 

• SimFx_User_Manual.pdf 

• MoTrak_Operator_Manual.pdf 

A copy of the software is available upon request to the GIfMI Site Manager. 
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8 SimFx software 

Before continuing, be sure that you have administrative rights to install this software on the computer. If you do not have 

administrative rights, you will be unable to install SimFx. If you are unsure of your administrative privileges, contact your 

System Administrator. 

 

8.1 Software installation 

  

 

1. Insert the SimFx installation CD into your CD-
ROM drive. If the CD does not automatically 
start, navigate to your CD-ROM drive in 
Windows Explorer and open Setup.exe to 
launch the installation 

 

  
2. Click Next when you see the window.  

  

 

3. Click I accept the terms in the license agreement 
and click Next to proceed with the installation. 

 

 

  

 

4. Enter the Customer Information in the window 
shown. Specify a User Name and Organization or 
check with your system administrator for 
appropriate information. This step is optional. 

 

 

5. Click Next to begin transferring files to your 
computer. 
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6. Click Next to install to the Destination folder.   

 
  

 

7. Click Install to begin the installation.   

  

 

8. Wait for the installation to finish.  
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9. If SimFx was installed properly, you will see the 
following window. Click Finish to complete the 
installation. 

 

 
 

8.2 Opening the application 

Once you have successfully installed the SimFx software you can open the application through the Windows Start Menu. 

  

 

1. Start the application via the Windows Start 
menu or by double clicking the SimFx icoon on 
the Desktop. 

 

 

  

 

2. Wait for the application to load  

  

 

3. The Graphical User Interface will show.  
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8.3 The User Interface 

8.3.1 General 

SimFx contains recordings of scanner sounds and ambient noise. There is also the possibility to add your own files to the 

library. The software allows you to play four audio files simultaneously. The volume of each sound file can be adjusted 

individually during playback. The following file types are supported: .wav, .mpa, .mp2, .mp3, .au, .aif, .snd, and .wma. 

The library contains the following sound clips: 

De bibliotheek bevat de volgende geluidsfragmenten: 

Background Sounds 

File Name Scan type/Description Length Sound Type 

AmbientNoise.wav White noise, static 10s mono 

CryogenicPump.wav Noise from cryogenic pumps in scanner room 7.47s mono 

AmbientCryogenic.wav Ambient.wav and CryogenicPump.wav in one .wav file 7s mono 

 

Scanner Sounds 

File Name Scan type/Description Length Sound Type 

GE_DTI.wav Diffusion Tensor Imaging sequence 14.29s mono 

GE_SE.wav Spin Echo sequence 9.89s mono 

GE_EPI.wav Echo Planer Image sequence 4.89s mono 

GE_GRE.wav Gradient Echo sequence, 2D low resolution structural (InPlane) 4.77s mono 

GE_SPGR.wav Incoherent Gradient Echo (RF Spoiled), Spoiled GRASS sequence 7min mono 

Siemens_DTI.wav Diffusion Tensor Imaging sequence 16.80s mono 

Siemens_Echo.wav Fast Spin Echo sequence 10.35s mono 

Siemens_EPI.wav Echo Planer Image sequence 59.60s mono 

Siemens_Localizer.wav Low resolution structural image sequence 14.29s mono 

Siemens_MPRAGE.wav Gradient Echo 3D high resolution structural sequence 6m5s mono 

Siemens_PD-T2.wav Proton density T2 weighted Image sequence, low resolution 
structurals  

57.35s mono 

 

 
You need Administrative rights to add/change/remove any sound file. 
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8.3.2 Load Sound 

In order to load a sound file, click the Browse buttons located on the right side of the application, navigate to the 

appropriate directory and select the desired sound file to be played. The browse file window will automatically open at 

the designated location of the installed sound files. 

  

 
 

1. Click on the Browse button to select a file. 
 

 You will be directed to the default 
Sound Folder location which is: C:\Program 
Files(x86)\PST\SimFx\Sounds. XP users will 
be directed to C:\Program Files\PST\SimFx\ 
Sounds unless you designated a different 
location at the installation. 

 
 
 
 

  

 

2. Select a file. 
 
 
 
 
 
 
 
 
 
3. Click Open. 
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8.3.3 Play Sound File 

The Play and Stop buttons will be disabled until a sound file is loaded in one of the text boxes. The checkbox that 

corresponds with the loaded sound file must be checked for SimFx to play the file. The sound file playback is controlled by 

the start and stop buttons located at the bottom of the application. 

  

 

4. Confirm the checkbox is checked. The text will 
appear in the digital display. 

 
5. Click Play to begin playback. 
 
6. Click Stop to terminate playback. 
 

 Once playback has begun, the loaded 
sound file cannot be changed before 
playback is terminated. 

 
7. Check the equalizer. 

 

 If the equalizer is animated, but you 
cannot hear the sound, check that the 
system volume is not muted or turned down 
and check the speaker connections.  

 

 

8.3.4 Volume controle 

The volume control for each sound file is located beneath the digital display. The slider is used to control the volume of 

the associated sound file. To decrease the volume, drag the slider to the left, and increase the volume by dragging the 

slider to the right. 

  

 

1. Click and drag the slider left and right to 
increase or decrease the volume. 

 
2. The text below the slider indicates the volume 

level (%). 
 

 The volume control for each sound file 
is located beneath the digital display. 
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8.4 File Menu 

8.4.1 Basic Features 

The File Menu consists of two options, File and Help. The File option of the File Menu contains general application 

functionality such as the save, open, exit operations. The Help Menu contains a link to the documentation and information 

about the SimFx installation. 

   

 

1. New: This menu option clears all user defined 
configurations, and returns the application state 
to default.  

2. Open: Allows a previously saved configuration to 
be loaded. 

3. Save: Saves current user configuration into a file. 
If the configuration does not initially have a 
name, you will be prompted to name the file This 
includes the loaded sound files, volume slider 
values, the folder of sound files and the settings 
of the serial port. 

4. Save as: Saves current open user configuration 
into a file. The name of the file is specified by 
user. 

 

 

 

 From here on advanced functionality will be described which is not strictly necessary to use the application. 

SimFx installs several sample sound files in a default location on the installation system. This location can be accessed via 

the File Menu for convenience. The default sound folder can also be changed to any folder located on the system. Please 

note, you must have administrative privileges to write to the default sound folder location. 

  

 

 

1. Click File and select Sound Folders. 
 
2. Click User Defined Folder. 
 
3. Browse to desired location you wish to save your 

sound files. 

 The sound folder must be located in 
My Documents. 

 
4. Click OK. 
 
5. Confirm the Default Folder is set to the location 

of the sound files to be played. 
 
6. Click OK. 

 The location of the sound files can be 
reset at anytime by selecting the Default 
Folder option via the File Menu.  
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8.4.2 Configuration 

SimFx is able to communicate with other entities via serial connection. The Configuration option in the File Menu opens 

the Serial Communications options. You will need to determine which COM port is assigned to your serial port. The state 

of Serial Communications is displayed in the right corner of the application opposite the File Menu. Basic information 

regarding serial ports settings can be found in Section 8.5: COM Port Settings. If you have questions about your serial port 

configurations, please contact your network administrator or other computer support personnel 

  

 

 
 

1. Click File and select Configuration. 
 
 
2. Click the COM port drop down menu to set the 

appropriate COM port.. 
 

 A warning dialog will appear if a port is 
unavailable on your machine.  

 

 If you have not determined what COM 
Port number is assigned to your serial port 
please contact your network administrator 
or other computer support personnel. See 
Section 8.5. 

 
3. Click OK to close the Serial Communications 

dialog. 
 

4. Verify Serial Communication is enabled via the 
checkbox in the upper right corner of the user 
interface. 

 

 If Serial Communications cannot be 
enabled by checking the check box at the 
top of the user interface, please check that 
the device settings are correct. See Section 
8.5. 
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8.4.3 Open Log File Location 

SimFx includes a log file that can be used to double check the application's functioning. The log file is opened via the File 

Menu. This file contains information and operations performed by the SimFx application. 

  

 

 

1. Click File and select Open Log File Location. 
 
 
 
 
 
 
 
 
 
2. The SimFxLogFiles dialog lists the location and 

file names of the available SimFx Log Files. 
 
 

 

 

This is an example of the SimFx log file. It is a tab delimited file and can be opened in notepad. This file tells you the current 

Serial Communications settings, current sound folder location, and a list of the operations performed by the SimFx 

application. 

    Current Sound Folder Location (sound file) 
  
 Serial communication settings (Initializing Serial Port ComPort = COM1) 
  
 List of Actions performed by application 
  
 What sound file is played (Audio File Location = Siemens_EPI.wav) 

 

  

SimFx Log 

--------------------------------- 

--------------------------------- 

Event Details 

SimFx Initializing N/A 

sound file:  C:\Program Files (x86)\Pst\SimFx\Sounds 

Initializing Serial Port ComPort = COM1, BaudRate = 9600, Parity = None, DataBit = 8, StopBit = 

One 

ConfigureSerialPort() 

Play Ambient Audio Audio File Location = AmbientCryogenic.wav 

Pause Scanner Audio via Checkbox Audio File Location = Siemens_MPRAGE.wav 

All sounds were stopped.  

Play Ambient Audio Audio File Location = AmbientCryogenic.wav 

Play Scanner 2 Audio Audio File Location = Siemens_EPI.wav 

All sounds were stopped.  

Play Ambient Audio Audio File Location = AmbientCryogenic.wav 

Pause Scanner Audio via Checkbox Audio File Location = Siemens_MPRAGE.wav 

All sounds were stopped.  
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8.5 COM Port Settings 

COM Port This option designates which port you want the program to use to communicate. 
Predefined values: COM1, COM2 
Default value: The User’s Default Communication Port (which will be found by SimFx) 
 

Baud Rate This option controls the number of data bits per second that are transferred via the selected port. 
Predefined values: 9600,14400,19200,28800,38400,56000,128000,256000 
Default value: 9600 

Data Bit This option will change the number of data bits you want to use for each character that is 
transmitted and received. 
Predefined values: 5,6,7,8 
Default value: 8 
 

Parity This controls the type of error checking the device performs. Please be advised that the computer 
or device you are communicating with must have the same setting as what you chose here. 
Predefined values: None, Odd, Even, Mark, Space 
Default value: None 

Stop Bit Changes the time between each character being transmitted. 
Predefined values: None 
Default value: None 

 

9 MoTrak system 
The MoTrak system is very complex. Contact the GIfMI Site Manager for more information. 
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10 MRI Simulator 
The MRI Simulator is easy to use. Below are some points of attention so that the device can last long if used properly. 

10.1 Power Supply 

   

 

The power supply for the Simulator is located 
towards the rear of the Bore section on the same 
side as the control panel. The Power Switch (P) is a 
manual reset circuit breaker. 
 

 Make sure the power switch is in the OFF 

position before   attaching the Power Cable.  
 

 Contact the GIfMI Site Manager if 
something is wrong with the cabling.  

 
Next tot he Power Switch is the Audio Input (A). 
 
 
 

 
 
 
 
 
 

 

10.2 Controle Panel Instructions 

  

 

The Control Paneel is mounted on the front panel.  
The control panel has three buttons: 

• ON/OFF switch (L) for Lights 

• ON/OFF switch (F) for Fans 

• Momentary button (T) button to move the 
Participant Table in and out of the MRI 
Simulator Bore. 

 
 
 

 

 

10.3 Ventilation 

Two  fans are located on the Simulator Bore. They are operated by a lighted ON/OFF switch located on the control panel. 

When active, the light switch on the control panel will be illuminated. 

10.4 Verlichting 

Lights are located in the Simulator Bore. They are operated by a lighted ON/OFF switch located on the control panel. 

When active, the light switch on the control panel will be illuminated. 

P 
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10.5 Participant Table 

10.5.1 Instructions 

A single press of the Table button on the control panel moves the Participant Table into the Bore.  Pressing the button 

again stops the Participant Table and pressing it one more time will cause the Participant Table to move out of the Bore. 

The Participant Table will move slowly upon initiation and will slow down again when coming to a stop. The Participant 

Table is equipped with a safety mechanism to reduce the likelihood of injury. It will automatically stop the Participant 

Table if it encounters too much resistance. 

10.5.2 Emergency Release 

   

 

There is an emergency safety release (E)) at the foot 
of the Participant Table that will release the table 
from the mechanism, allowing it to be moved 
manually. Pulling the knob towards the foot of the 
table releases the table from the Carriage Assembly. 
To re-attach the table slide the Participant Table 
forward with a moderate amount of force until you 
hear the table lock back into the Carriage Assembly. 
Pull on the Participant Table to verify it has locked 
back in place. 
 
 

 

 

10.5.3 Remote Control 

   

 

The table can also be operated with a remote control 
with button (T). This works identically as the control 
button on the control panel.  
 
This can be a useful tool for researchers doing self- 
testing or piloting experiments. This also provides 
anxious participants an element of control by 
allowing them to move themselves out of the 
Simulator. 

 

 

10.6 Mock Head Coil 

   

 

The Mock Head Coil is a two-piece unit designed to 
allow easy participant placement and simulation of 
“birdcage” style head coils used in actual MRI 
scanners. 
 
The bottom piec (CB) remains on the Participant 
Table, the top piece (CT) is easily removed for 
participant placement. A mirror (M) is mounted on 
the top piece to allow the participant to look at a 
screen at the end of the Bore or towards the feet. 
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10.7 Speakers 

The Simulator speakers can be driven by your computer audio card or any compatible sound source.  

The audio system of the Simulator consists of an Audio Input (3.5mm TRS plug mini jack) on the Power Supply and two 

Speakers on the side of the Simulator bore. 

The Simulator audio system is for simulated scanner sounds only and is not to be used as a substitute for an audio stimulus 

presentation system for the participant. 

 
To avoid hearing damage, it is important that the volume of the sound source is not too high. By testing in 
advance (without a participant in the bore) a comfortable sound level can be set. 
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11 Proper Placement of the Participant 
The following section is intended to help the researchers get optimal results from the use of their MRI Simulator. This is 

by no means an exhaustive list of proper or common simulator practices and procedures. It is intended to provide insight 

and suggestions to improve the simulator environment. 

The operator should go through all of the steps that an MR technician would normally go through in a normal scanner 

session. They should include all items such as ear plugs and headphones, performing a standard screening just as they 

would in a normal scanning environment. 

Be sure to explain the expected experience and all aspects of the test for the participant before conducting any testing. 

They should be allowed to handle the stimulus response devices, view the stimulus presentation system and any other 

critical aspects of the scanner environment. 

If the participant is to be given the Participant Table Remote Control or any emergency device, instruct them on its usage 

and allow them to use it several times to assure their comfort and confidence of use. 

Upon completion of the experiment and withdrawal of the participant from the Simulator, give an exit interview to the 

participant. Exit interviews provide valuable information that might highlight potential problems that may occur in the 

actual MR runs (feelings of panic, discomfort, etc.) and can be used as feedback to improve the simulator environment. 

Explain any differences between the simulator and actual scanner experience. Some examples might be; room 

temperature, separation of the scanner and control rooms, and the presence of additional staff. 

Each participant reacts differently to the MR environment. It is important to acknowledge this and to offer a training 

tailored to the participant. 

12 Points of Attention 

 The maximum load-bearing weight is 125 kg. 

 Ensure that the hands and hair of the subject cannot get between the table and the bore to avoid injury. 

 Make sure the sound volume has been tested beforehand to avoid hearing damage. 

 Make sure that the participant can safely get on and off the table by using a step. 

 Make sure that everything stays clean. Do NOT use alcohol but water or the available tissues. 

 Ensure that participants are sufficiently instructed about the course of the practice session. 

 Make sure the emergency stop works. 

 Servicing may only be done by qualified personnel. In case of problems, contact the GIfMI Site Manager. 

 

• It is possible to copy the sound files from the default location (see section 8.3.2) to an external drive (USB stick, CD, 

mp3 player, ...). The sound files can be played independently of the SimFx software. Given the short duration of the 

sound files, it is recommend to put the player in "loop" mode so that sounds are repeated continuously. See the 

manual for your specific player for more information. 

• With certain populations, and especially with children, it is important that there are different training sessions. After 

a visit to the MRI Simulator, the child can practice at home by lying very still on bed and listening to the sounds. If 

necessary, extra training sessions on the MRI Simulator can be scheduled. The child can get used to the noise so that 

this is much less a determining factor in the success of a scanning session. 


